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1. Executive Summary:

Studying competitor’'s latest patents or patent applications is a fast and
effective way to learn what they are working on and how their technical
achievements might impact your current or future projects. Furthermore, it offers
an invaluable opportunity to have your mind enlightened with innovative ideas,
which may lead to your own invention to counteract your competitor's patent or
an approach to bypass it. However, technology frontiers are often frustrated by
doing that due to difficulties originated from two aspects: insufficient time
permitted by daily work and reading-unfriendly nature of patent documents.
Invention Alert helps technology frontiers overcome these difficulties by letting
them concentrate their valuable time on studying patent documents of the most
mattered entities, and, improving their studying productivity through an integrated
management environment specialized for reviewing patent documents.

Invention Alert is a software platform designed and built for promoting
technology awareness on recently published patents or patent applications of
designated entity. The entity may be an Inventor entity (researcher or engineer),
Assignee entity (company, organization, or institute), SearchMacro entity (virtual
entity representing a validated search query), Group entity (research group or
development team), Field entity (technical field), or Project entity (entity created
in accordance with any going-on project). The software works like researcher’s
virtual personal assistant, which is constantly monitoring published patent
records of designated entity and gives alerts for newly found patent records at
the earliest available time. Furthermore, the documentations of alerted patent
records, including both specifications and drawings, will be downloaded
automatically from USPTO online servers and formatted accordingly for review.
When responding to the alert of a newly found patent record, researcher could
immediately access the patent documentation of the record, without having to
manually find and download the documentation. Therefore, researcher will be
aware of any patent or pending application of designated entity recently as soon
as such the record is made available to public by USPTO. Because the

designated entity reflects researcher’s most pertinent interest, researcher’'s time



is better saved for reviewing content of patent documentation, instead of being
squandered on searching and monitoring. In addition to automatic patent alerting,
Graphic user interface of the software provides an integrated management
environment for managing and reviewing the found records. Through the user
interface, researcher could view list of found records for each entity, assign
status of the found records for future reference, and, interactively browse both
specification and drawings of selected record through built-in Interactive Patent
Document Viewer. The interactive patent viewer helps reader easily find
interested sections on specification, and browse drawing-related contents of
specification through cross-document references between the specification and
the drawings. Reader no longer has to scroll page and page to find drawing of a
figure referred in specification. Instead, by one mouse click, drawing of a figure
referred in specification will be brought to screen for reader to view. Vice versus
also works from drawing page of a figure to contents in specification referring to
the figure. The interactive reading response enabled by the interactive patent
viewer relieves reader from the most tiring and boring reading action of switching
back and forth between specification and drawings in order to combine teachings
of both. Thus, reader is less likely to get fatigue and will achieve much higher
reading efficiency. Other crucial data of patent documentation are also reachable
by reader through just one mouse click or operation. In conjunction with other
useful features, the interactive patent viewer will dramatically increase
productivity of patent studying.

The major features of Invention Alert are summarized as following:

(1). Being alerted at the earliest possible time about recently published
patent or application of designated entities;

(2). Having patent documentation including both specification and
drawings downloaded automatically;

(3). Being able to create entity for patent alerting at minimal effort through
the self-instructive graphic user interface;

(4). Being able to perform complex patent searching and alert monitoring

by creating a SearchMacro entity, which may be any combination of inventors,



assignees, other SearchMacros, classifications, and keywords, through entity
based graphic query construction;

(5). Reviewing patent documentation through built-in interactive patent
document viewer, which is designed specifically to promote reading and
comprehension of patent documents;

(6). Managing patent records for future reference by assigning them
different statuses and giving comments;

(7). Using the software like an online patent searcher but being benefited
by the graphic user interface, graphic query construction, automatically
downloading patent documentations, automatic record analysis, and built-in
interactive patent document viewer.

Using the software requires very minimal effort from researchers or
engineers. So, they can focus their limited time on studying merits of inventions.
The genera; procedure of using the software may be condensed to following
steps:

step 1: define entity that is to be monitored for patent alerting;

step 2: being automatically alerted for any latest patent or application of
the entity;

step 3: reviewing patent documentations of alerted records through

Integrated Record Management Environment.



2. Graphic User Interface

2.1 Main Window — Viewing Entities and Records
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Toolbar

Background Update History

>
Srropas | Wheds | ghGoups
A ivemtons | AL Assignees | @) Scorchin

Mlerts | Records | Pretie ||

4 Patent 2627 AppPub Blert: 4454 Atention: 0 Permanent 0 ||
X appleinc ¥ 10276/ 10276 BiH

T |Tide 1t Lwerstar Assignes Mumber  Date Mlsrted On Viewed On f
X Google ¥ 2154/ 2164 i

P Abbreviation detecton lor sommen SyTamym genemtion Easier, Steven D, Goagle Ine.
X orace ¥ 7007/ 7007 P Abusé-resstant method of regilening User ccounts with ant Coleman, Geth |, Google Ine
A rrocson ¥ 200/ 200 P Accelerated lange scaie optimization Stoutamire. Davd  Google Inc.
X intet ¥ 13372723371

P Accelerated parning user intar

Teang, Erick Geogle Inc.

P Actelessting uaes intertsces by

Fredricksen, Cic i Goegle Ine

P Accens-influenced search resubs Hayes, Bamy Google Inc 04/12/2013

ntrofied search results Mguyen, Phuong | GoogleInc. 7500263 10/05/2008 0
a target chject with desiced functionaiity Sigurdsson, Johan  Google Inc 04/12/2013

P a target chject with desired functionality Sigurdsson, chan  Goagle Inc.
I| A arget Object With Desired Functionsity Sigurdssan, Johan  Google Inc.
Ill A 265 TO NETWORK Eukard, Tmo  Google Inc.
A ACCESS TO NETWORK COMTENT Jain, Aevnd Goagle Ine
\ P Actess using images “III Eger, David Thom  GoogleInc
1 P Actess using images Eges, Daved Thom  Goagle Ine.
\ A accis SEARCH INTERFACE |r.a'.|:-uc|u'a||f ISEM Crow, Dariel M. Google e 201000
1 P accerdion user intertace i Vourg DsidS  Googlelne  BISEIST O/ o
Il P Account recovery key \ Tsao Mickasl Google Inc. TEI0451 107272008 O
\ A ACCOUNT-RECOVERY TECHNIQUE \ Cathcart Robers Google. e, 2000050 12/02/2010

P Accuracy analyss of wireless base station iocation ‘oussef, Adel Ami GoogleInc. &

P Accurete aligreent of multiphe aser scans using & temphite 3

Anguelcy, Dragor  Googlelne. 209143

P Accurate aligrment of multiple laser scans using a templaje 5 Anguelov, Dragor Google Inc.  B209144  06/2

P Accuretely estimating advertsement perlermince \ Veach, Eric Hugh  Geeglelne  7B1E2(8 1001

P Achieving advertising campagn gos's | Kewchum, Russell | Geoglelne  BLITOET 021142012

| : \\I :

x \

Treeview of Entities Listview of Patent Records

Count of Attention status \

Count of Alert status
Count of Application Publications

Count of Patents

Count of Records

mme e K ---------------------------------------------------------------

. '
) 1
: 1l
: Total: 44 Patent: 26. AppPub: 1837 E
- Eee s e i — — | !
) -
Ny T | Title 1st Inventor Assignee Number Date Alerted On  Status Change  Viewed On E
] 4

] L P Ahhrewi@ detection for common synonym generation aker, Steven . Google Inc. 8122022 02/21/2012 02/27/2013 02/27/2013 E
)

1 L 4 P Abuse-t method of user accounts with an«) Coleman, Keith ). GoogleInc. 8023927 09/20/2011 02/27/2013 02/27/2013 E
] : ;

: 4 P Accelgrated large scale optimization Stoutamire, David GoogleInc. 7730074 06/01/2010 02/27/2013 2272013 E
i . o
1_Y_I1_P_ Acclersted panming wser intefoce imeractions_______| Tseng Brick ___Googlelnc 8201341 107162002 022772013 oy |}

Click coiumn header to sort list Drag column edge to adjust width and double click for autofit

Main window, as illustrated above, has majority of window area occupied
by two view panes: left treeview pane of all created entities categorized
according to type of entity into tab views, and, right view pane selectable for
displaying entity profile, list of all records, or list of alerted records for the entity

currently selected on left treeview pane. If there is alerted record for entity, a red



flag following by a number will appear immediately next to the entity on entity
treeview pane. The number following the red flag indicates how many alerted
records are in the entity. Entity profile allows user to quickly view biological
information of the entity. Statistics about status counts of listed records is shown
on top of listed record, giving user a quick recognition of overall status. Each
patent record has its key information listed as one row of the listview. For each
row of the listview, user could see status of record, type of record, title, first
named inventor, assignee if any, patented or published date, alerted date, last
status change, and last viewed date. User may sort list of records by clicking
column header. For example, clicking column header of “Title” will sort records
according to alphabetic order of titles. The sorted records may be further sorted
by clicking another column header. From the list of records, user can change
status of record by clicking status icon (the first column). User can also view
more detail information by moving mouse cursor over desired column data.
Among them, a very helpful feature is to quickly review abstract and first claim of
listed records by hovering the mouse cursor over title of each record. To view
complete documentation of a listed record, double clicking title area or number
area of the record will open built-in interactive document viewer in a separate
window.

Alerted records have status icon of a red flag shown at beginning of record
row. To sort records to have alerted records listed first, click the icon of Red Flag
at beginning of header row. To find latest alerted record, user can further sort the
records by clicking column header of “Alerted”. To facilitate review of alerted
records, enabling tab of “Alert” on right pane will show list of records with “Alert”,
“Attention” and “Permanent” statuses. For the case, records of “Attention” and
“Permanent” statuses are also shown because user may want to see them too
when going over alerted records.

Entities are divided as element entity and cluster entity. Element entity can
not contain other entity but may be contained by cluster entity. Element entity
includes inventor, assignee and SearchMacro. The most important parameter for

element entity is search query, which is generated and validated during creation



of the entity. User does not input search query directly, instead, they only provide
necessary information to identify the entity and search query will be generated
automatically from the identification information in accordance with USPTO
online server query syntax. This process relieves user from learning the server
guery syntax and is much less error prong. SearchMacro is an advanced feature
that allows user to create complex search query through select-and-drop
operation on corresponding graphic user interface. (Referring to section 6 for
more details about SearchMacro). In contrast, cluster entity does not have the
parameter of search query because it is updated by combining updated results of
its containing entities, not involving directly updating with USPTO server. In short
word, cluster entity provides user a convenient way to manage patent alerting for
user-defined group, field or project. For example, user may create a group entity
for an interested research group, and, add inventor entities for each group
member into the group entity. Then, any alerted record for nay inventor entity
contained by the group entity will also appear as alerted record for the group
entity. Furthermore, cluster entity is assigned with levels and higher level entity
may contain lower level entity. In sequence, project entity has the highest level,
thus may contain field entity, group entity, or element entity. Field entity has the
second highest level, thus may contain group entity or element entity. Group
entity has the lowest level among cluster entities, thus may only contain element
entity. It is worth to mention here that, if user wants to include keyword or
classification search in field entity, keyword and classification search are
embedded in creation of SearchMacro. To do that, user needs to create a
SearchMacro entity including keyword or classification search and add the

SearchMacro entity into the field entity.

2.2 Menu Item — File
Refer to following submenu items for details.
Create: Go to submenu selection to choose new entity to create.
Modify: Go to submenu selection to choose existing entity to modify.
Modify Selected: Modify entity that is selected currently on left pane

treeview.



Remove: Delete entity that is selected currently on left pane treeview.
Please be recognized that the entity may be contained by other entities or
containing other entities. Deletion of the entity will cause involved entities to be
modified accordingly.

Save All: Save all changes made on entities.

Save Selected: Save change of currently selected entity.

Save Selected As: This function is used to duplicate selected entity.

Export: This function is used to export entities for sharing with colleagues
or coworkers. Export file is in XML format.

Import: This function is used o import entities from XML file exported by
Invention Alert. Please note that import entities will appear as newly created
entities and will not be compared with existing entities to avoid duplicity.

Exit: Exit program. Upon exiting, some closing or cleaning operations may
start automatically. Program will close after those operations, if applicable, are

completed.

2.3 Menu Item — View
Refer to following submenu items for details.
Projects: When selected, left pane switches to list of Project entities.
Eields: When selected, left pane switches to list of Field entities.
Groups: When selected, left pane switches to list of Group entities.
Inventors: When selected, left pane switches to list of Inventor entities.
Assignees: When selected, left pane switches to list of Assignee entities.

SearchMacros: When selected, left pane switches to list of SearchMacro

entities.
Patent Document: When selected, a popup window allows user to input

patent number or application publication number of a patent record to view its
document in interactive patent document viewer. This is a fast lane to open the
viewer for a patent document if the patent or application publication number is

known.

2.4 Menu ltem — Tools

Refer to following submenu items for details.



Update Now: Manually start background update through user interface.
Another way to start or stop background update is to click application icon of
IAscheduler in application tray (refer to below for more information).

Scheduler: I1Ascheduler is a small program running as soon as user logs
in his/her account. As soon as it starts running, an application icon is shown in
the application tray. User can interact with 1Ascheduler through application tray.
The program primarily does two functions: first, start background update
automatically in accordance with time of day and day of week set by the
parameters of this menu item; second, periodically show a notice on lower-right
corner of screen to notify user current status of Invention Alert in accordance with
the notification parameters set in this menu item. User does not need to change
the default setting unless it is inconvenient.

Priority: Set priority of background updating for element entities. The
higher level number gives higher priority. This feature is useful when there are
several entities each having a large number of pending records. In this case,
user may set one entity having higher priority than the other to ensure pending
records of the entity will be downloaded first.

Settings: View or change settings for a variety of operations as followings:

Runtime Data Directory dictates root directory of all runtime data including

status report, logs, entity data, record data, runtime settings, and so on. Unless
necessary, please don’t change this directory. If this directory is changed, user
needs to restart program to let the change take effect. Furthermore, user must
manually copy all subfolders and files from the previous directory to the new
directory when both Ul program and background update program are not
running.

Record Status Linked, if checked, makes default condition of interactive

patent document viewer having record statuses across containing entities linked
together, which means changing record status would change the status across
all relevant entities.

Cleaning Unused Document, if checked, will cause files of unused patent

records to be deleted, which means they won't be retained for future use.



Update Notice Count tells how often Ul program update its displayed

records in accordance with newly available records downloaded by currently
running background update program. For example, default value 100 means, for
every 100 document records downloaded by background update program, Ul
program will update its displayed data with the newly available data. This setting
only takes effect when background update is running when user is accessing
data through Ul program.

Including Drawings In Showcase, when enabled, will cause showcase file

to be generated including drawings of each selected patent documents. If not
enabled, normal showcase file only includes front pages of selected patent
documents. It should be cautious to enable this setting because it is very easy to
make generated showcase file very large size. Log Level dictates how detail
logging should record. This setting is reserved for debugging serious problems
and should not be changed for normal use.

Validate Search Page Limit is to set a limit on pages to be downloaded

when validating newly created entity. Each page corresponds to 50 patent
records to be downloaded and analyzed. It is noted that this page limit applies on
patent and application publications separately, which means each of them is
allowed to have the maximum number of records limited by the page limit to be
downloaded and analyzed. This page limit is implemented to prevent mass
downloading activity when validating new entity, which is not only unnecessary
but also very time consuming.

Forward: Default email sending program, for example Microsoft Outlook
or Thunderbird, is automatically opened with PDF files of selected patent records
already attached in attachment. User only needs to type in recipient’'s email
address and a short note to forward the selected patent documents to others.

Showcase: Compile front pages of all selected patent documents into a
single PDF file. User can quickly go over selected patent documents by
examining the front pages and find interested ones for viewing details. This kind
of searching technique is often used by examiner to quickly go through a large

number of references. User has option to include drawings of patent documents
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in the showcase, but must be aware of potential to generate very large size file.
Choose View to open default PDF viewer to view generated showcase file.
Choose Forward to view generated showcase file and forward the file as

attachment through email.

2.5 Menu Item — Help
Refer to following submenu items for details.
EAQ: Open default help viewer for a list of frequently asked questions.
Tutorials: Open a window to display a series of short tutorials for most
useful features of Invention Alert.
Manual: Open default help viewer for complete manual of Invention Alert.

About: Display copyright notice, version number and product key.

11



3. Entity Management

3.1 Create Entity:

For creating element entity, goto File->Create->Element Entity, then
select entity to create. For creating cluster entity, goto File->Create, then select
entity to create.

Procedure to complete creation of element entity consists of two major
steps: step 1 is to fill identification information of entity; step 2 is to validate
search query automatically generated from filled identification information. User
may need to repeat stepl and step 2 several times in order to confirm correct
identification information is provided. Each validation is performed automatically
by submitting search query to USPTO server and retrieving and analyzing a
certain number of patent documents found by the search query. Analyzing the
retrieved patent documents helps user to find interested entity and confirm the
searched entity is indeed what user is looked at. Analysis result is displayed on
left pane of Analysis section of entity creation window. Retrieved patent
documents are listed on right pane of the Analysis section. User may view
content of patent document by double clicking title or number of the record, which
will open interactive patent document viewer for browsing the content. To save
time for the analysis, only limited number of found records are retrieved. If user
opens a record with no content retrieved so far, user may click Update button on
the interactive document viewer to immediately start online retrieval of the
content for viewing. Details of using interactive document viewer is described in
section 5. It is noted that creating SearchMacro entity is an advance search
feature and its usage is described in detail in section 6.

Procedure of creating cluster entity is different from creating element entity
because cluster entity does not rely on search query for updating, instead, relying
on other entities that are contained by. For this reason, cluster entity starts with
filling in biographic information by user. The biographic information is defined by
user at will and solely for helping user remember and manage a group of entities.
It may correspond to a real thing or be completely virtual. After defining the

biographic information, cluster entity is created but has to add containing entities
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in order to be useful for any means. In next show-up profile edit window, user is
able to add other existing entities into containing list of the new cluster entity.
Once this is done, the new cluster entity will be updated regularly and giving alert
notices according to newly updated results of its containing entities. User can
later change the containing list by modifying the cluster entity.

3.2 Modify Entity:

There are two way to initiate editing entity. First way is to goto
File>Modify and select type of entity to modify. User will choose entity to be
modified in a popup window that lists all exiting entities sorted by types into tab
controls. Second way is to select the entity to be edited on left pane treeview,
then choose File>Modify Selected or click edit icon in toolbar to open profile
editing window for the entity.

In profile editing window, user may revise biological information of entity
excepting information affecting search query, comments, containing list and
contained-by list. Biological information for element entity affecting search query
can not be modified here because any change to that will affect search query.
Those information must be revised through entity creation window. To open the
window, user may click “Modify” button next to search query. Please remember
that any change affecting search query must have changed search query
revalidated before being able to save the change. Containing list shows entities
that are included by the entity under viewing or editing. It is noted that only lower
level entity may be included in the containing list and the current entity may be
contained by higher level entity. To add an entity, select the entity to be added on
tabbed view list. If the selected entity has lower level, arrow button pointing at the
containing list will be enabled. If the selected entity has higher level, arrow button
pointing at the contained-by list will be enabled. Then, clicking the enabled arrow
button will add the selected entity into corresponding list. By adding to the
containing list, the selected entity will be included by the current entity. By adding
to the contained-by list, the current entity will be included by the selected entity.

To remove an entity from either containing list or contained-by list, select the

13



entity from the list and “Remove” button will be enabled. By clicking the enabled
“Remove” button, the selected entity will be removed from the list. When entity is
added or removed, patent records of corresponding cluster entity will be updated
accordingly to either include patent records of added entity or remove patent
records of removed entity. After any change is made, “Save” button will be
enabled and must be clicked to save the change. If change has been made, user
may click “Restore” button to discard the change and restore to saved data of the

current entity.

3.3 Change Update Behavior:

Element entity will have its latest updated date displayed in profile edit
window. This updated date is set automatically by background update program
when latest background updating is completed. For special purpose, user may
want to set this date manually. For example, by setting this date to a future date,
background updating of this entity will be disabled until after the date. For
another example, by setting this date to a past date, background updating of this
entity will be surely performed at next updating. To manually set the updated
date, press “ctrl” key down and click the calendar icon next to the date will open
an input window for user to set new date. To clear the updated data, which sets

the date to default value, press “ctrl” key down and click “Reset” button.
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4. Record Status Management

Invention Alert not only provides automatic alert for newly published patent
records according to designated entity, but also allows user to effectively manage
and review found patent records. When a patent record is alerted first time, it is
given a status of “Alert”. In right pane list of patent records, such status of “Alert”
is represented by a red flag icon positioned at beginning of paten record row.
After reviewing the alerted patent record, user may give the record a different
status as a conclusion to its importance to user’'s own work. The statuses include
“Alert”, “Attention”, “Permanent”, “Normal”, and, “Remove”, which are suggested
to set according to following rules:

“Alert”: Record is supposed new and requires reviewing as soon as
possible;

“Attention”: Record is reviewed and considered very pertinent to the user’s
works, thus worthy periodically going over;

“Permanent”: Record is reviewed and considered worthy preserved for
future references;

“Normal”: Record is reviewed and its value has been evaluated;

“Remove”: Record is not pertinent herein, thus marked for removal.

Please be noted that record marked as “Remove” is not actually removed,
but will not be shown in the list. Doing so will prevent that, if the record later is
found again in background updating, it will not be alerted since the record has
been marked as irrelevant.

User may change status of record by clicking status icon of record row in
right pane list of records. Or, user may change status of record in interactive
patent document viewer when reviewing content of the record.

The status management allows each patent record to be marked
according to its importance and relevance to pertinent entity. When user wants to
go over the patent records for a specific entity, user may easily find best valuable
records to study first, thus having his/her limited time used for getting best return

of knowledge.
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5. Interactive Patent Document Viewer
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Abstract

Some embodiments of the invention shift the responsibility for creating parity
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B
5
Inventors: Woodhouse; David (Braintree, GB) -g
714/800 2 o
147624 Applicant: Name City State Country Type =
1147758 g
714/801 ‘Weodhouse; David Braintree N/A  GB
4 Figures Assignee: Intel Corporation(Santa Clara, CA)
i Appl. No.: 12/644.217
. Filed:  December 22, 2009

\ Current U.S. Class: 714/800 ; 714/6.24; 714/758; 714/801
Current International Class: GO6F 11/00 (20060101)
References Cited [Referenced By]

U.S. Patent Documents

March 1996 Ford
November 1998 Hohenstein et al.
December 2006 Kiselev etal.
: January 2012 Hafhner et al.
\
\
Patent Classifications

Figure Links Figure Caption  Figure References

PDF Patent Document

Interactive patent document viewer is specifically designed to ease
reading and comprehending patent document. Once opened, the viewer has a
separate window hosting two browsers for respectively browsing specification
and drawings of patent document, as illustrated in above image. The primary
innovative feature provided by the viewer is to allow interactive browsing
responses between specification browsing and drawing browsing. This feature is
realized by creating cross-linked references between specification and drawings.
In content of specification hosted by specification browser, every location
referring to a figure is placed with a reference cross-linked to corresponding

drawing page of the figure. When the reference link on specification is clicked,
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the drawing page corresponding to the link is brought into current view by
drawing browser. This provides instant response to make drawing of interested
figure viewable when user is reading to a referral of the figure on specification.
Vice versus, each drawing page hosted by drawing browser contains a number
of numeral links under each figure caption, each of which corresponds to a
referred location on specification regarding the figure. By clicking the numeral
link, corresponding referred location on specification is instantly brought to top of
view by specification browser. Furthermore, each browser allows user to
independently browse specification or drawings by scrolling up and down. For
illustration of using, one scenario of using the viewer is like following: user views
content of specification on specification browser by scrolling up and down; when
user reads to a location referring to a figure number, user clicks the figure link on
the location and instantly starts to view drawing of the figure on current view of
drawing browser; Then, when user scrolls up and down to view drawing of a
figure on drawing browser, user clicks one of numeral links under the figure
caption and instantly starts to read referring location of the figure on specification
browser to find out how the figure is referred to describe the invention. The
interactive responsiveness between browsing specification and browsing
drawings dramatically improves reading efficiency and the fast response
promotes user's comprehension on combined teaching of drawing and its
relevant written descriptions.

As illustrated in above image, interactive patent viewer also has a
reference pane on left side of the viewer window, which displays some key
information for patent record and sectional references of specification and figure
references. When user clicks sectional reference on the reference pane,
corresponding section of specification will be brought to top of view by
specification browser. When user clicks figure reference on the reference pane,
drawing of corresponding figure will be brought to current view by drawing
browser. These references provide a convenient and fast link to find desired
content or drawing. Furthermore, it is sometimes useful for user to find out how

the patent document is classified by USPTO. To help that, user may read class
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definition of classes to which the patent document is classified by either double
clicking class number on the reference pane or hovering mouse cursor over class
number to show up a tooltip window displaying the deification. To help user
quickly read figure captions, user can move mouse cursor over figure reference
on the reference pane, which, in turn, causes show-up of a tooltip window
displaying caption of the figure.

Following screen-captured images illustrate some operations of the
interactive viewer as described above. In sequence, these images respectively
illustrate: clicking a section reference on the reference pane brings the section of
specification to top of view and clicking a figure reference on specification brings
drawing of the figure to current view of drawing browser; clicking a numeral
reference under figure caption on drawing browser brings the referred location on
specification to top of view; hovering mouse cursor over class number on the
reference pane causes show-up of a tooltip window displaying definition of the
class; hovering mouse cursor over figure reference on the reference pane

causes show-up of a tooltip window displaying caption of the figure.

Once clicked, bring the section of

specification to top of view. Once clicked, bring the drawing page
Figure Reference of the figure to current view.

Section Reference
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DETAILED DESCRIPTION

In the following description, numerous specific details are set forth. However, it
is understood that embodiments of the invention may be practiced without these
specific details. Well-known circuits, structures and techniques have not been
shown in detail to avoid obscuring an understanding of this description.
References to "one embodiment”, "an embodiment”, "example embodiment”,
"various embodiments” and the like indicate the embodiment(s) so described
may include particular features, structures, or characleristics, but not every

Figure 2 embodiment necessarily includes the particular features. structures, or

—\5‘5
H i Lk

Figure 3 characteristics. Further, some embodiments may have some, all, or none of the
Figure 4 features described for other embodiments. Also, as used herein "first”, "second",
A "third" describe a common object and indicate that different instances of like
0 ‘i‘r"e - objects are being referred to. Such adjectives are not intended to imply the
e POF

objects so described must be in a given sequence, either temporally, spatially, in
ranking, or in any other manner.

5 H Figure 6 includes a system block diagram for use with an embodiment of the |-
Various embodiments of the invention address data storage issues (e.g., the m?"mu\ml'
"write hole" issue) present with. for example, RAID formats such as RAID-5 mEm
and RAID-6 svstems. However. embodiments of the invention are not limited o~
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|| embodi of the presentinvention. Multip system 50§ is a point-to-
point interconnect system. and incllides a-first processor 570 and
processor 580 coupled via a point-to-point interConnect 550. Each'of processors
570 and 580 may be multicore processors, including first and seco
cores (i.e.. processor cores 574a and 574b and processor cores 384 \aind 584b),
although potentially many more cores may be present in the processors. The
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includes a MCH 582 and P-P interfaces 586 and 588. MCHs 572 and 582 couple
the processors to respective memories, namely a memory 532 and a memory
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714/800 534, which may be pottions of main memory (e.g.. a dynamic random access

7147524 memory (DRAM)) locally attached to the respective processors. First processor

714/758 570 and second processor 580 may be coupled to a chipset 590 via P-P

714/801 interconnects 552 and 554, respectively. Chipset 590 includes P-P interfaces 594
Figures and 598,

Top

Battom Furthermore, chipset 590 includes an interface 592 to couple chipset 590 with a

Figure 1 high performance graphics engine 538. by a P-P interconnect 539. In turn,

Figure 2 chipset 590 may be coupled to a first bus 516 via an interface 596. Various

Flaige3 input/output (/O) devices 514 may be coupled to first bus 516, along with a bus

Figuee 4 bridge 518, which couples first bus 516 to a second bus 520. An audio I/O 524

feuee.3 may be coupled to second bus 520. Various devices may be coupled to second
v F‘i“D'f & bus 520 including, for example, a keyboard/mouse 522, communication devices

i 526.

Data storage unit 528, such as a disk drive or other mass storage device such as
aRAID system. may also be coupled to bus 520. Unit 528 may include code 530
| or other data or instructions. Although the discussion herein has focused at
times on disk-based file svstems. embodiments of the invention mav be used

S term "processor” may refer to any device or portion of a device that processes
:s:;m clectronic data from registers and/or memory to transform that clectronic data ™
Hebance into other electronic data that may be stored in registers and/or memory.

;T,:,mc First processor 570 further includes a memory controller ub (MCH) 572 and
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includes a MCH 482 and P-P interfaces 586 and 588. MCHs 572 and 582 couple
the processors fo respective memories, namely a memory 532 and a memory
534, which may bc portions of main memory (c.g.. a dynamic random access
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now to FIG. 6, shown is a block diagram of a system in accordance with an

cmbodiment of the present invention. Multiprocessor system 500 is a point-to-
||| point interconnect system, and includes a first processor 570 and a second

processor 580 coupled via a point-to-point interconnect 550. Each of processors
"¢ ||| 570 and 580 may be multicore processors, including first and second processor
cores (i.e.. processor cores 571a and 571b and processor cores 581a and 584b),
although potentially many more cores may be present in the processors. The
term “"processor” may refer to any device or portion of a device that processes
electronic data from registers and/or memory to transform that electronic data
into other electronic data that may be stored in registers and/or memory.

First processor 570 further includes a memory controller hub (MCH) 572 and
«| | point-to-point (P-P) interfaces 576 and 578. Similarly, second processor 580
includes a MCH 582 and P-P interfaces 586 and 588. MCHs 572 and 582 couple
the processors to respective memories, namely a memory 532 and a memory
534, which may be portions of main memory (c.g.. a dynamic random access
memory (DRAM)) locally attached to the respective processors. First processor
570 and second processor 580 may be coupled to a chipset 590 via P-P
interconnects 552 and 554_ respectively. Chipset 590 includes P-P interfaces 594
and 598.

Furthermore, chipset 590 includes an interface 592 to couple chipset 590 with a
high performance graphics engine 538. by a P-P interconnect 539. In turn,

chipset 590 may be coupled fo a first bus 516 via an inferface 596. Various
input/output (I/O) devices 514 may be coupled to first bus 516, along with a bus
bridge 518, which couples first bus 516 1o a second bus 520. An audio I/O 524
may be coupled to second bus 520. Various devices may be coupled to second
bus 520 including, for example, a keyboard/mouse 522, communication devices |

View PDF|T
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In additional to displaying references, the reference pane has two tabs
respectively for “Other Entities” and “Comments”. “Comments” tab is for user to
leave a comment for the patent document. “Other Entities” tab shows other
entities that have the current viewed patent document included in their patent
records. In the tab, user can change status of the patent record for each other
entity. If cross-entity status linked is enabled, change of the status for current
entity will apply the same status for all other entities having the same patent
record included thereby. This is a very useful feature to manage status of patent
record if the record is included by multi entities. User can disable the cross-entity
status linked feature by either clicking the icon next to status selection on right-
upper corner or through linked controls on “Other Entities” tab.

User may also view the documentation in PDF format by double clicking
“View PDF” on references pane. The PDF file of the documentation will be
opened by default PDF viewer of Windows operating system. From there, user
may print the documentation if wanted. If PDF file is not opened, user may install

a PDF viewer on your computer and make it default for viewing PDF file.
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“Find” function is very useful to find word or words matched with input. If
“Current” option is selected, clicking “Find” will have all matches in current
document highlighted. If “Other” option is selected, user may input a patent
number or an application publication number to retrieve specification and
drawings of corresponding patent record. If the patent record had been
downloaded, the interactive viewer will load its files from local storage.
Otherwise, the viewer will automatically download related files from USPTO
server. This feature gives user a quick way to view patent document if patent
number or application publication number is known. Please be noted that you
can view any patent document through this feature, no matte whether or not it is

included by any entity.
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6. Advanced Search — Use SearchMacro

Graphic Query Construction Pane Level 1 Enclosure

Entity Selection Pane
/ Level 2 Enclosure
& Creating SearchMacro . .1! \ i N \'\\

Entity Name: SearchDema 1 Created By: Demonstrator Query: (AN/"Godgle ) AND (JAN/"Oracle ") OR (JAN/"Apple ") ANDNOT (AN/"Microsaft ) ) U’ah}!{ne Close

ications | P Keywords Undo| ' |Redo Clear

b Eoond ® b (R EIE e oL v ) 4

Root Enclosure

AND Operator

' OR Operator ADNNOT Operator
Root Enclosure

Hits: 0 Documents - O Patents 0 AppPubs Analyzing / Listing: 0 /0 Documents 0/ 0Patents 0/0AppPubs Download Limit: 10 =

mber T Titie 1stInventor Assignee Date Alerted On  Viewed On

Above screen-captured image illustrated appearance and usage of
SearchMacro Creation window. When user choose to create a new SearchMacro
entity through user interface, a window of creating SearchMacro as above image
is openned. The primary difference between SearchMacro creation window and
other element entity creation window lies on the middle section of the window,
which is divided into two panes: left pane for entity selection and right pane for
graphic query construction. Other element entity creation, instead, needs user to
input identification information in order to generate initial search query.
SearchMacro entity itself doesn’t have a real entity to be corresponded to. The
biological information of SearchMacro entity is up to user to define for easy
remembrance or convenience. Key value of SearchMacro entity lies on its search
query construction, which allows user to create search query for any combination
of existed entities. Furthermore, the query construction is graphic objects based

and very easy to use through select-and-drop mouse operation. Primitive
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procedure to add an entity can be completed by two steps of the mouse
operations. The procedure starts with selecting the entity from entity selection
pane by either through context menu enabled by right mouse button pressed or
sliding mouse cursor on the entity icon for a very short distance while holding left
mouse button. Then, adding the entity to graphic search query is as easy as
dropping selected or held entity icon on desired location within scope of the
graphic search query. By default, AND operator is used as connection operator
of the dropped entity. To change to other connection operator, click on the
operator and repeat until it is switched to desired operator. To add the entity in
the same level as an existing entity, the added entity should be dropped either
before or after the existing entity. Directly dropping the added entity on an
existing entity is treated as to combine the added entity with existing entity, which
causes the added entity and existing entity to be contained by a next level
enclosure.

Entity selection pane contains a tab control including a number of tabs,
each of which is for a type of element entity. When one tab is enabled, entities
corresponding to the type are listed for selecting. It is noted that the table control
has tabs for Classification entity and Keyword entity, which are designed only for
being enclosed by a SearchMacro entity. User can create classification entity and
keyword entity by either through context menu of tab header or clicking entity
icon on tab header. Once created, classification entity or keyword entity must be
enclosed by a SearchMacro entity to be effectuated for patent updating or
alerting. Of course, user may create a SearchMacro entity enclosing only one
classification entity or keyword entity, thus effectively making the entity like a
stand-alone entity for patent updating or alerting. Because SearchMacro entity
can hold any combination of other element entities, it is best suitable for creating
more complex search query. For example, combining an Assignee entity with a
classification entity or keyword entity in a SearchMacro entity is in effect like
applying a filter of classification or keyword search on the assignee entity. By
repeating select-and-drop operation for each added entity, user can quickly

construct very complex search query through graphic query construction pane.
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Graphic query construction pane is where user finally constructs search
qguery. Graphic query is represented graphic objects enclosed within scope of
root enclosures, which is symbolized by a curled bracket with a number of “0” in
middle. The number of enclosure symbol indicates its levelness of enclosing. So,
root enclosure has enclosing level 0. Root enclosures are always presented to
indicate beginning and ending of the graphic query. To add first entity into the
graphic query, select the first entity from entity selection pane and drop the entity
between the two root enclosures. To add second entity, select the second entity
from entity selection pane and drop the second entity between the two root
enclosures. The two entities will be automatically connected inside the root
enclosures with a default “AND” operator in-between. To change the operator,
clicking on the operator will cause the operator to next one of a sequence of
“AND”, “OR”, and “ANDNOT". Repeat that until getting desired connection
operator. To add third entity, after selecting the third entity from entity selection
pane, drop the third entity in front of or behind an existing entity to make the third
entity inserted in the same level as the existing entity. Or, drop the third entity
directly on an existing entity to make the third entity inserted as combining with
the existing entity, both of which are then enclosed by a level 1 enclosure as a
combination. The insertion logic stands valid for any following operation. With the
same way, user can create a search query made of a collection of entities at any
combination relations desired thereby. Furthermore, user can revise graphic
query by right clicking an exiting entity object to enable context menu and
choosing action shown on the context menu. User may also use “Undo”, “Redo”
and “Clear” button to revise the graphic query. Behind the graphic query, real
search query in accordance with the graphic query will be generated
automatically and, once validated and saved, will be used for patent updating
and alerting.

It is emphasized that SearchMacro creation window may be used as a
stand-alone patent searcher taking all advantages of graphic query construction.
The above description introduces primitive functions of SearchMacro creation

interface. User is encouraged to explore details for taking full benefits of this tool.
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7. Background Update

Background update is started automatically by IAscheduler according to
setting parameters for Scheduler. To view or change the setting parameter, go to
Tools—>Scheduler. User has option to set whether to do background update daily
or on a specific day of week and what time of day to start background update.
Background update runs in background and won't affect use of the computer.
User is given notice by IAscheduler when background update is started and
completed. User may check status anytime by open status window of
IAscheduler through system tray. IA scheduler is a very small program running
as soon as user logs in. It primarily does one job that is to start background
update automatically. User may also manually start background update by
opening status window of IAscheduler and choosing “Start Background Update”.
Another way to manually start background update is to go through menu
operation of User Interface. To abort currently running background update, user
may open status window of IAscheduler and choose “Stop Background Update”.

Background update completes a two phase process. Phase | is to update
all element entitles pending for update to find out whether there are newly
published patent records for the entities. Because USPTO only makes new
records published on Tuesday of each week, element entities are necessary for
updating only after Tuesday of each week. When any element entity is found to
have newly published patent record, cluster entities containing the element entity
will be updated accordingly. After completing Phase | entity updating, Phase I
updating is to download documentations of newly found patent records. Each
documentation includes both specifications and drawings. If there is any records
previously found but not having complete documentation downloaded, these
records will be updated to have their documentations downloaded as well. To
avoid putting too much workload on downloading, a daily download limit is
applied to phase Il updating. The download limit applies to both newly found
records and existing pending records, but counting them separately. Current
download limit is 500, which means, for each start of background update,

maximum 500 newly found records and, if applicable, maximum 500 exiting
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pending records are allowed to be downloaded. Records not being downloaded
this time will be downloaded in following runs of background update. Here, user
is assured that no record will be discarded and all records remain in storage and
are available for user’s review. Only effect of this download limit for each run is
that user may open interactive viewer to view a record but find no content is
available for viewing. In such case, user can click “Update” button on the viewer
to retrieve the contents immediately. For most case, this even won't be
encountered by user because pending records will be downloaded automatically
in following runs of background update, which by default runs once every day.
This download limit for each run won’t cause any problem or even any
inconvenience at all because, by just delaying for a couple of days, a huge
accumulative number of records would be downloaded automatically. For user’'s
normal working habit, it is not likely that a user is able to review more than 100
patent documents in a working day. Therefore, the download limit for each run is
reasonable and implemented for avoiding unnecessary heavy internet usage in a
short time period. If user has special purpose that indeed needs to raise this limit,
please contact vendor for a customized program.

The background update program uses multi-threading pipelined module
architecture, thus capable of competing intended tasks at fast output speed and
taking full advantages of multi cores of processor. For reference purpose only,
following data gives an example of how fast the background update could
complete record downloading and processing. For a desktop computer having
one Intel i7 940 quad-core processor and 6 GB memory and a Western Digital
7000 rpm hard drive, with high speed internet access, downloading 500 patent
records could normally be completed within 25 to 30 minutes. During the
downloading, average 40% to 60% CPU load for four cores of the i7 processor
was commonly observed. The desktop PC had a good air cooled CPU cooler
installed, which kept core temperature in range of 50°C to 56°C at normal room

temperature.
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8. FAQs — Frequently Asked Questions
1. How to install the software?

After downloading the zip file of the software package, double click the zip
file to view its contents or unzip the file. From contents of the zip file, run
Setup.exe by double clicking the file and follow instructions. Please read
Readme.txt or Readme.rtf before running Setup.exe. User must have
administrator privilege in order to complete the installation. But, using the

software does not require administrator privilege.

2. What should | pay attention to during installation?

Unless there is special need, you can let the windows installer complete
installation on its own. However, you should make sure the data file root
directory, where all runtime data including downloaded patent documents are to
be saved, does not require administrator privilege to access. Typical directory
where user can save his/her data files should be fine. Directory for operating
system files requires administrator privilege and are not suitable for storing data
files. During installation, you will be prompted by installer to choose location of

the data root directory.

3. Do | need to activate license?
The installation process will automatically activate the installed program
package through online activation. You will be prompted prior to the online
activation during the installation. No user’s input is further required to complete

the online activation.

4. Can | repeat installation on the same computer?
The license permits installation and use of the software product on one
computer only at any time. Unless the installation is performed on the same
computer, you can repeat installation as many times as you need. If system

setting is correct, the repeated installation won't have effect on already installed
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program package. If system setting has error, the repeated installation will

correct that.

5. Can | uninstall the software and reinstall on another computer?

You are permitted to do so only when the terms of End User License are
satisfied. To do so, you must uninstall the software from currently installed
computer and, during uninstallation, choose “Deactivate” when you are
prompted. After completing the uninstallation, you may reinstall your copy of
software on another computer. Be noted that such automatic deactivation and
reinstallation on a different computer can only be performed automatically for one

time.

6. What should | do if installation fails?

We apologize for such issue happening. If the installation is run with
administrator privilege, the installation process typically only fails when online
activation can not go through. This may be caused by temporary downtime of our
online activation server. Please wait for several hours or one day to repeat the
installation. If the installation continues to fail, please submit a support ticket
through Customer Support on our website. You will get feedback in two or three

business days.

7. What are key features of Invention Alert?

Invention Alert is designed and built for two primary purposes: first,
automatically alerting and downloading newly published patents records for
entities designated by user; second, promoting efficiency of managing and
studying patent records. With the two purposes realized, technical personnel may
focus their very limited time on investigating technical merits of most pertinent
patent records, thus being keen to competitor’s progress and, meanwhile, being
enlightened to new or improved idea leading to bypass solution or own invention.
Followings are key features that collectively make the intended purposes become

true:
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. Automatically alerting newly published patent records for designated
entities;

. Automatically retrieving patent documents for patent records from
USPTO patent and publication servers;

. Browsing key data of patent documents through list of records for quick
review;

. Reviewing details of patent record including specification and drawings
by using built-in interactive patent document viewer, which is specialized to
promote reading and comprehending patent documentation;

Managing patent records by assigning status marks and giving
comments for future reference,;

. Creating entities for alerting through graphic user interface;

. Creating advanced search query through graphic query construction by
select-and-drop mouse operation;

. Viewing or sharing PDF files of patent documents;

. Viewing or sharing a showcase file of a collection of patent documents,
which is best suitable for quick reviewing or searching prior art;

. Sharing created entities with others through import/export functions;

. Using advanced search feature only for online patent searching if desired
so, but still taking advantages of using graphic query construction based on entity
objects, automatically downloading found patent documents, and reviewing

downloaded patent documents with built-in interactive patent document viewer.

8. How to start patent alerting?
To start patent alerting, user needs to create an entity to be monitored for
patent alerting. User creates the entity through corresponding entity creation
interface. Once the entity is created, it is automatically under monitoring for

patent alerting.

9. How to view alerted patent records?
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When there is an alerted record for an entity, user will see an icon of Red
Flag immediately next to the entity in entity treeview pane. A number following
the red flag icon indicates how many alerted records are in the entity. User can
click on the entity to view a list of records included by the entity on right pane,
wherein alerted record has an icon of Red Flag at beginning of record row. To
view the list with alerted records shown first, user may sort the records by
clicking the icon of Red Flag at beginning of header row. To find latest alerted
record, user may further sort the records by clicking column header of “Altered”.
User can quickly review key data of alerted records by moving mouse over
different column sections of record row. By double clicking on title or number of
record, user can view details of patent documentation by opening the interactive
patent document viewer. User may also open PDF file of patent documentation
through the viewer if operating system has a default PDF viewer installed.

10.How to create an entity for patent alerting?
Go to File>Create. Then, select type of entity to create. After that, entity
creation interface is opened. Complete creation of entity through the interface.
The entity must be saved at the end. Once the entity is created, it is automatically

under monitoring for patent alerting.

11.How to create Inventor or Assignee entity?

Go to File>Create->Element Entity->New Inventor or New Assignee to
open entity creation interface. In the entity creation interface, input biological
identification of entity and validate the automatically generated query. If query is
validated, a small number of patent documents for the entity will be automatically
downloaded and analyzed to give a statistics report. From there, user can further
refine or confirm the entity. One useful feature is that user can right click on
inventors or assignees shown on statistics pane and select “Copy To” to copy the
inventor or assignee information to the entity, or, select “Save As” to create a
new entity based on selected inventor or assignee. If search query is changed,

user must revalidate the entity. After finalizing the entity, user can save the entity
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and the entity is created. Please be noted that Inventor entity corresponds to a
real inventor person and Assignee entity typically corresponds to a company,
institute or organization. So, user should create an Inventor entity for a technical

person who invents and an Assignee entity for a business entity.

12.How to create SearchMacro entity?

Go to File > Create > Element Entity > New SearchMacro to open
SearchMacro creation interface. Not like Inventor or Assignee entity,
SearchMacro is a virtual entity designed to combine other element entities
together through logic operators of “AND”, “OR”, or “ANDNOT”". Because there is
no real entity to be corresponding to, biological information to be inputted on the
creation interface is purely user defined for easy remembrance or convenience.
Key value of SearchMacro entity lies on constructing graphic query made of
graphic objects of other entities connected by logic operators. The entity object
based graphic query is constructed through the creation interface using select-
and-drop mouse operations. To add an entity, user selects the entity from entity
selection pane of the creation interface and drops the selected entity into graphic
guery. When the selected entity is dropped in front of or after an existing entity
object on the graphic query, the dropped entity is inserted to the same enclosure
level as the existing entity. When the selected entity is dropped directly on an
existing entity object on the graphic query, the dropped entity and the existing
entity are combined together into next enclosure level. “AND” logic operator is
added by default to connect the dropped entity with existing entities. User may
change the logic operator by clicking the operator. At any time, user may revise
the graphic query by moving an existing entity object forward or backward or
removing an existing entity object. For constructing the graphic query, user may
select any entity from existing Inventor, Assignee and SearchMacro entities. In
addition, user may create Classification entity or Keyword entity only for
constructing the graphic query. To do that, user may click entity icon on tab of
“Classifications” or “Keywords” to open its creation interface and complete the

creation through the interface. Then, user is able to select and drop the created
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Classification or Keyword entity into the graphic query. It is noted that
Classification entity and Keyword entity are only used for creating SearchMacro
entity, thus not being effective for patent alerting or updating unless they are
included by a SearchMacro entity. Of course, user may decide to create a
SearchMacro entity only for containing a Classification entity or Keyword entity in
order to make it effective for patent alerting or updating. However, normally, a
useful SearchMacro entity should contain more entities for a meaningful
subjective.

Real search query is generated automatically in accordance with current
object structure of the graphic query. After completing construction of the graphic
guery, user must validate search query in order to be able to save the
SearchMacro entity. After validating, user may revise the graphic query, but
having to revalidate for the changes. Once finalizing the graphic query, user must

save the SearchMacro entity to complete the creation.

13.Can | directly revise search query of element entity?

Yes. But, unless you are very familiar with query syntax of USPTO patent
searching, you should not directly revise search query. You can always change
information or structure of entity to have search query automatically updated
according to your change. If you really need to directly change search query,
pressing “ctrl” key and double clicking on field of search query will make it
editable through keyboard input.

14.How to create Group, Field, or Project entity?

To open entity creation interface, go to menu File - Create and selected
entity type. Group, Field, and Project entities are cluster entity. They are created
through a two step procedure. First step is to enter biological information by user
for defining and identifying the entity. Second step is to add lower level entities to
be included by the entity into its containing list, or add higher level entities to
include the entity into its contained-by list. Please refer to manual for more

details. After that, the entity can be saved and become active for patent alerting
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or updating. Be noted that patent records included by a cluster entity are
determined by its containing sublevel entities. It also stands true for patent

alerting of cluster entity.

15.How to review detail content of patent record?

Interactive patent document viewer is a built-in tool specialized for help
reading and comprehending patent documentations. The interactive viewer
makes simultaneously browsing specification and drawings very user-friendly
and efficient. To open the interactive document viewer, double click title or
number of patent record from the list of records. The specification and drawings

of the patent record will be automatically loaded by the viewer for review.

16.What are key features of built-in Interactive Patent Document Viewer?

The interactive patent document viewer has specification content and
drawing content respectively hosted by two browsers. Each browser has one
view pane to display partial content and browse full content by scrolling up or
down. The two view panes sit horizontally one next to the other, occupying
majority of view area of the viewer. This arrangement helps user read one
content portion of specification while being able to view drawing page relevant to
the content portion. Furthermore, cross-pane links are inserted into both
specification and drawings so that clicking a figure reference link in specification
instantly brings relevant drawing page of the figure into view, or, vice versus. This
interactive response between specification browsing and drawing browsing
dramatically promotes user’'s reading experience and comprehension on
teaching merits of specification and drawings. The interactive viewer further has
a reference pane containing sectional links to specification and figure reference
links to specification and drawings, when clicked, causing relevant content
become immediately viewable on respective browser.

Following summarizes key features of interactive document viewer:

. Interactively browsing specification and drawings as a whole;

. browsing specification and drawing independently if wanted,;
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. finding section of specification or drawing page of figure by a single
mouse click;

. viewing class definitions of patent classifications;

. managing patent record for future reference by setting appropriate status
and giving comments;

. updating online content of documentation automatically if necessary.

17.How to manage a record for future use?
When a patent record is firstly found, it is assigned a status of “Alert”. When the
record has been reviewed, user may assign it another status according to its
significance and relevance to its containing entity. Available statuses include
“Alert”, “Attention”, “Permanent”, “Normal” and “Remove”. Status of “Attention”
means the record is worthy for come-back review. Status of “Permanent”
indicates the record is closely relevant to its containing entity and should be
reserved for future reference. Status of “Normal” indicates the record is relevant
but not innovative, thus not likely to be referred in the future. Status of “Remove”
indicates the record in irrelevant to the entity, thus disabled from future reference.
By assigning the record appropriate status, user can have records well organized
for future use. Furthermore, user can give comments to reviewed record to
facilitate future use. Status of record may be changed by clicking status icon of
record in list of records, or through interface of interactive document viewer. To
give comments to a record must go through interface of interactive document

viewer.

18.How to manage status of a record included by multi entities?

When a record is owned by multi entities, user may sometime want to
assign it a uniform status across all the entities. To do that through each entity
would be cumbersome. Interactive document viewer offers a convenient way to
set status of a record across all of its containing entities. First, open
documentation of the record by interactive document viewer. Second, make

statuses of all of its containing entities cross-linked. By default, the cross-entity
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statuses are linked together, which is indicated by a linked ring icon next to
status selection. User can switch to unlinked by clicking the icon. Another way to
change cross-entity status is to go through tab of “Other Entities” on references
pane. This feature provides user a fast way to manage the same record across
multi entities. Be careful that it may be necessary to assign different statuses to

the same record for different entities.

19.What advanced search could | do through Graphic Query Construction of

SearchMacro Creation Interface?

Graphic query construction of SearchMacro creation interface can be used
to easily create any combinations of existing entities. Therefore, potential to
create very complex search query is endless, but still easily and reliably doable
due to object based graphic interface and select-and-drop mouse operation.

20.Can | use the software only as a patent online searcher?

Yes. Graphic query construction of SearchMacro creation interface can be
used to easily create any combinations of searching entities. User can use this
interface to perform online patent searching, meanwhile greatly benefited from
automatically downloading and analyzing found records and reviewing
downloaded documentations through interactive patent document viewer. Please
be recognized that the software delivers much more useful and powerful
functions than an online patent searcher could do.

21.When does automatic background update start?
Background update will automatically start in accordance with setting
parameter of Scheduler. User may view or change the setting through Tools >

Scheduler. By default setting, background update starts at 4pm every day.
22.How to start background update manually?

User has two ways to start background update manually. One way is

through user interface by going to Tools - Update Now. The other way is to
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open IAscheduler notice window by clicking application icon inside application

system tray, and, then, click button of “Start Background Update”.

23.How to abort a currently running background update?
Open IAscheduler notice window by clicking application icon inside
application system tray. If background update is running, click button of “Abort

Background Update”.

24 Will aborting background update cause any side effect?

No. Background update started either automatically or manually will
always check current statuses of existing entities and records at startup, then,
run updating accordingly. So, aborting a running background update won't cause
any side effect.

25.What should | act if background update seems running unnecessarily
long?

Occasionally, background update may take much longer time to complete
when network traffic is slow or error on network is experienced. If you do not
want background update to continue running, you may abort the background
update through application icon of IAschedule on system application tray. Later,
background update will automatically restart as usual according to scheduler
settings. You may also start it manually if wanted. But, it is unnecessary and

perfectly fine to leave it alone.

26.How to disable updating of an entity?

To disable updating of an entity, open profile edit window of the entity.
Press Ctrl key and click calendar icon next to date of updated. This will open an
input window for user to type in a new date. Once saved, the updated date is set
as inputted date. If a future date is inputted, updating of the entity is disabled until
the inputted date. It is emphasized that only element entity is applicable for the

case.
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27.How to redo updating of an entity?
To redo updating of an entity, open profile edit window of the entity. Press
Ctrl key and click calendar icon next to the updated date. This will open an input
window for user to type in a new date. To redo the updating, just input a past
date. When next background update starts, the entity will be updating from the
inputted date. To redo completely updating of the entity, press “Ctrl” key and click
“Reset” button to reset the updated date to default date.

28.How to set priorities among entities active for updating?
Go to menu Tools > Priority. Then, change level numbers for entities to

set priorities. The higher level number gives higher priority.

29.How to share a patent document with my colleague?
Select the patent record on list of records on right pane. Then, go to menu
Tools - Forward. This will automatically open a new email window of default
mail agent program with PDF file of the patent record already attached as
attachment. User can type in recipient’s email address and a brief note to send

the email with attached PDF file to colleague.

30.What is a showcase?

A showcase is a collection of front pages of a number of selected patent
documentations. The showcase allows user to quickly go over front pages of
selected records and find out record that is close to user’s interests and worth for
detail review. This feature is very useful to search interested subjects or prior art
among a collection of patent records. To generate a showcase, go to menu Tools
- Showcase > View. User may optionally include drawings of each patent
records in the showcase. To do that, go to menu Tools - Options, then, check
checkbox of “Including Drawings in Showcase”. Be careful to enable this option
because it may potentially generate very large size file.
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31.How to share a showcase with my colleague?

User may share a showcase of selected patent records with colleague
through email. To do that, go to menu Tools - Showcase - Forward. The
showcase file in PDF format will be generated and then attached as attachment
in a new email window of default email agent program. User may send the email
to colleague after inputting email address and a brief note. User must watch the
size of generated showcase file before sending, because email server typically
applies a file size limit on attachment. If the file size is too large for emailing, user
can find the generated showcase file at {Runtime Data
Directoryl\Data\Showcase. (Note: Runtime data directory can be found by going

to menu Tools - Options.)

32.How to have a showcase including drawings?
Go to menu Tools - Options, then, check checkbox of “Including
Drawings in Showcase”. Be careful to enable this option because it may

potentially generate very large size file.

33.How to export entities?

Go to menu File - Export. Then, user can select entities to export in
popup window. After clicking OK, user will be prompted to decide directory and
file name of export XML file. User will get a report regarding export status when
export finishes.

34.How to import entities?
Go to menu File - Import. Then, in file selection window, select an export
XML file to import. User will get a report regarding imported entities when import

finishes.

35.Why do | need import or export of entities?
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You can share the entities with your colleague. So, they can have the
same entities under monitored on their computers, assuming legitimate copies of

Invention Alert are installed.

36.How to change data root directory where all runtime data are stored?

Go to menu Tools - Options. In the popup window, change path of
Runtime Data Directory. User should exit user interface program immediately
after changing this directory. Furthermore, all stored data should be manually
copied to the new directory when both user interface and background update are
not running. Unless disk is running out of storage space, user should not change

the directory path.

37.1s there any tutorial illustrating typical user scenario?
Yes. If you have the software installed, you can view tutorials through user
interface program by choosing menu Help - Tutorials. If you don’t have the

software installed, go to our website at http://www.inventioncrossing.com and find

webpage for Tutorials.

38.Where can | find more documentations?

Please go to our website at http://www.inventioncrossing.com and find

webpage for Documentations.

39.Do | get free upgrade for future release?

Yes.
40.How to install upgraded version?
Invention Alert software will notify user when upgrade version is available.
The upgrade version will be automatically downloaded and installed after user

responds to the notification.

41.Can | request refund if the software does not work properly?
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Within 30 days after purchase, if the software does not work properly, we
will give refund for full price of the purchase subject to user's agreement of
destroying any copy of the software received including installed copy and, if

applicable, any backup copy.

42. How to contact vendor?

Please go to our website and submit a support ticket online through
Customer Support. Normally, it takes us two to three business days to respond a
request. Please go over online documentation first before submitted a support
ticket because we may only answer question not explicitly available on online

documentation or question from existing customer.
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